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IMPORTANT

Adobe announced on March 1, 2021 that it will no

longer develop or support Brackets starting September
1, 2021

Adobe suggests that users move to Visual Studio Code,
which I second

For info about VSCode, see www.granneman.com/all-
presentations for slides


https://www.granneman.com/presentations/all-presentations
https://www.granneman.com/presentations/all-presentations

Installation



Windows, macOS,
& Linux




Brackets i1s available for download at brackets.10


http://brackets.io

1 Brackets Contribute APl Docs Blog Support

A modern, open source text editor that
understands web design.

Download Brackets 1.7 CliCk thiS

Other Downloads

& index.html| — Brackets
Working Files <div id="hero-wrapper">
<div id="hero" class="row'">
<div class="large-12 columns'>
<hl>Brackets 1is an open source code editor for web designers and front-end developers. <a class='"noh
<div id="download">

<a id="hero-cta-button" href="https://github.com/adobe/brackets/releases/latest" class="large rd

iIndex.html

brackets.io | larz/vl v |

.gitignore X brackets.io.css: 378 | NewRule ¥
404.htm!

#hero-cta-button {
font: 400 18px source-sans-pro, sans-serif;
CNAME text-align: center;
padding-left: 1.5em;
padding-right: 1.5em;

blog.html

contribute.html

CSS






A file named something like
Brackets.Release.l.7.dmg will download

Double-click on the DMG installer & a small window
should open



Brackets Release 1.7

2 items

Brackets.app

Brackets Release 1.7

Drag Brackets into the Applications folder



Favorites

2% rsgranne
] Desktop

@ AirDrop
:/'A\; Applications
™ iCloud Drive

& ¢
2 Dropbox

@ Documents
@ Downloads

] WebSanity Share
® [ Inbox

[=] DEVONthink PDF CliCk = tO ej eCt (OI’ I'ight-CliCk OIl
' ‘the name & select Eject)

=) BOOTCAMP
Q Remote Disc

|_| Brackets Releas... 2 [age it

After Brackets finishes copying, eject the DMG installer



Toss the DMG installer into the Trash (select the file &
press x)







A file named something like
Brackets.Release.1l.7.msi will download

Double-click on the MSI installer



Click Run
Click Next & then Install

If you're asked if you want to “allow the following
program to install software on this computer”, click Yes

Click Finish



Toss the MSI installer into the Recycle Bin



Portable Brackets



How Brackets
Works




Open Brackets



) Index.html (Getting Started) — Brackets

Getting Started <IDOCTYPE html>
<html>

index.html

main.css

<head>

S - <meta charset="utf-8'">

Y ajelicisiseliopiz | | | <meta http-equiv="X-UA-Compatible"
content="IE=edge">

<title>GETTING STARTED WITH BRACKETS</title>
<meta name="description" content="An
interactive getting started guide for

Brackets.">
9 | | <link rel="stylesheet" href="main.css'">
10 | | </head>
11V | | <body>
12 | | | |
13 | | | | <h1>GETTING STARTED WITH BRACKETS</h1l>
14 | | | | <h2>This 1is your guide!</h2>
i fls
167 | ||| <l
17 | | | MADE WITH <3 AND JAVASCRIP

11 M

Line 10, Column 12 Li INS HTML ¥ Spaces: 2



First
Extensions




HTML Templates,
Updated



o0 index.html (selectors) — Brackets

Naraag Elles 1 <!doctype html>
index.html 27 <html ]-ang="en">
3 <head>
4 <meta charset="UTF-8">
5 <title>CSS Selectors</title>
6 <link rel="stylesheet" href="styles/main.css'">
7 </head>
@ abelincoln.gif 8 <body>
index.htm| 9
styles 10 <hl>We’r| aaiable Themes Installed Default i
main.css 11
12 <div 1id=
13 < p> HTML Templates, Updated nserts HTML from a pre-made list of templates.
14 On t '
1S < / p> 1 265
16 <ol> - _
17 B
18 1 - |
19 <Li>
2O </01> Brackets Link File New: jsDelivr API 2. Easily link your files (PHP,
21 </div> JavaScript, CSS, images, audio, video, fonts) into the
22 O el b e
23 <p>
24 Lorem ~ nec quis diam placerat, laoreet lacus
BN | Drag zip here or Install from UR 2. tur blandit, sem nec congue rutrum,
risus UTTEULa ULTrICTES TUrpTS, €u VvenenatTs auT nTst-a aotor. Etiam molestie commodo dolor 1d
facilisis. Nullam id diam ex. Pellentesque pellentesque quam nisl, ac aliquam metus commodo
quis. Morbi egestas aliquet felis dignissim mattis. Vivamus augue libero, ultricies ut blandit
non, bibendum sed eros.
25 </p>
26
27 <p>
28 Lorem ipsum <strong>dolor sit amet</strong>, consectetur adipiscing elit. Donec quis diam

Line 2, Column 15 1 Errors: 14 INS UTF-8 = HTML » (’f} Spaces: 2



0 This repository Pull requests Issues Marketplace Explore +~- -

¥ rsgranne / Brackets-HTML-Templates-Updated ®Unwatch~ 1  Star 2  YFork 49
forked from talmand/Brackets-HTML-Templates
<> Code Issues 0O Pull requests 0 Projects 0 Wiki Insights Settings
Brackets extension that provides basic HTML templates of various doctypes. Edit
Add topics
0 89 commits ¥ 1 branch O 2 releases 42 9 contributors

Branch: master » New pull request Create new file @ Upload files @ Find file Clone or download ¥

This branch is 24 commits ahead of talmand:master. 11 Pull request Compare

] rsgranne Updated version number to 1.3.6 Latest commit 3c844d8 27 days ago

B html Updated links to framework templates & added versions 28 days ago
B nis Updated strings 6 months ago
=) README.md Added more info re updates & additions to templates, & footnote re Sk... 28 days ago
=) main.js Updated for new template filenames 27 days ago
=] package.json Updated version number to 1.3.6 27 days ago
=) strings.js Implemented localization strings and updated modal to dialog system. 4 years ago

EE README.md




After installation, go to Edit > HTML Templates...



iIndex.html

iIndex.html

index.html (test) — Brackets

HTML Templates

Choose a template...

Standard doctypes
Choose...

Framework templates

These templates are based on HTML provided with the framework, so some adjustments will be

necessary.

Choose...

Cancel

Line 1, Column1 — 1 Line

INS

UTF-8 ¥

Spaces: 2




e index.html (test) — Brackets

S ,)\ { ™ "I : YT s ™
Working Files

index.html

test

HTML Templates

index.html

Choose a template...

Standard doctypes

v Choose...

HTML4 Transitional
HTML4 Strict
XHTML 1 Transitional
XHTML 1 Strict
XHTML 1.1

ovided with the framework, so some adjustments will be

Cancel

Line 1, Column 1l —1 Line INS UTF-8 ¥ | Spaces: 2



Working Files

o index.html

test

index.html

O 00O ~NOOOUL A~ WDNBK

e
O Ul A WNRKROO

Line 1, Column 1

e index.html (test) — Brackets

k!doctype html>
<html lang="en">

<head>
<meta charset="UTF-8">
<title>Untitled Document</title>

<link rel="stylesheet" href="/css/main.css">

</head>

<body>

INS

UTF-8 ¥

HTML ¥

Spaces: 2



Indentator



index.html (Getting Started) — Brackets

1 <!DOCTYPE html>
27 <html>

§ N Y
{ | g ) NS
L i K W

Available Themes Installed

|O‘ indentator

NOTE: These extensions may come from different authors than Brackets itself. Extensions are not reviewed and have full local privileges.

Be cautious when installing extensions from an unknown source.
index

: Indentator
main
Andrew Huth

Re-indent a document using your current indentation

settings.

Install
1.0.3 —05/12/2014

More info...

< /title>

quick-edit h

Drag .zip here or Install from URL...

17 MADE WITH <3 AND JAVASCRIPT

-1 M

Line 13, Column 46 — 208 Lines

INS HIML ¥ /)  Spaces: 2



After installation, go to Edit > Indent Document
Better yet, use the key commands!

» macOS: ~\<1
» Windows: Ctrl1+Al+t+T

Do not use Edit > Indent, as that just indents 1 line!



Working Files

index.html
test.html

Getting Started

index.html
main.css
screenshots

ladl quick-edit.png
test.html

O 00O NOOUL A~ WDN K

==
N = ®

13
14
IS
16

Line 14, Column 3

o test.html (Getting Started) — Brackets

<!doctype html>
<html>
<head>
<meta charset="UTF-8">
<title>Test Document</title>
</head>

<body> Before running the Indentator...

<hl>Test Title</hl>

<p>

Lorem ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor incididunt
ut labore et dolore magna aliqua. Ut enim ad minim
veniam, quis nostrud exercitation ullamco laboris
nisi ut aliquip ex ea commodo consequat.

<p>
Duis aute 1rure dolor 1n reprehenderit 1n

B [ IR S I | - =L e By R = [ = S o S-S = =g

INS HTML ¥ Spaces: 2



) o test.html (Getting Started) — Brackets

Working Files

<!doctype html>
<html>
<head>
<meta charset="UTF-8">
<title>Test Document</title>
</head>

<body> After running the Indentator...

index.html
test.html

Getting Started

index.html

main.css

O 00O NOOUL A~ WDN K

<hl>Test Title</hl>

screenshots

—
O

ladl quick-edit.png
test.html

—&
—

<p>
Lorem 1psum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

13 </p>

14

i B

€ r~ s - - e e i D i e R T Clg

i
N

Line 14, Column 1 INS HTML ¥ Spaces: 2



Run the Indentator after every few lines of code



Nu Markup Checker



test — Brackets

+ | | |= | Last Updated | I . nu markup
Available Themes Installed Default

NOTE: These extensions may come from different authors than Brackets itself. Extensions are not reviewed and have full local privileges.

3e cautious when installing extensions from an unknown source.

Nu Markup Checker for Brackets Adds Nu Markup Checker support to Brackts.
Takeshi Kurosawa More info...

0.1.1 — 08/18/2014

1 6049

Drag .zip here or Install from URL...




Nu Markup Checker runs every time you save



) o test.html (Getting Started) — Brackets

Working Files
<hl>Test Title</hl>

index.html

test.html
<p>

<p>
Getting Started Lorem “ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco lalioris nisi ut aliquip ex ea commodo

index.html
main.css

screenshots

ladl quick-edit.png

€
s " ¢p . Not correct HTML?
</p> Press Save...

<p>
Duis aute 1rure dolor 1n reprehenderit 1n voluptate
velit esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non proident,
sunt 1n culpa qui officia deserunt mollit anim 1d

est laborum.

1Q ¢ I'n>
Line 14, Column 9 INS HTML ¥ Spaces: 2




) test.html| (Getting Started) — Brackets

Working Files
<hl>Test Title</hl>

index.html

test.html
<p>

<p>
Getting Started Lorem +ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.
</p>
</p>

index.html
main.css
screenshots

ladl quick-edit.png
test.html

Error! Now click on it...

<p>
Duis aute 1rure dolor 1n reprehenderit 1n voluptate
velit esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non proident,
sunt 1n culpa qui officia deserunt mollit animiid

est laborum.

1Q ¢ I'n>
Line 14, Column 9 INS HTML ¥ Spaces: 2




Working Files

index.html
test.html

Getting Started

index.html
main.css
screenshots

ladl quick-edit.png
test.html

test.html (Getting Started) — Brackets

<hl>Test Title</hl>

<p>

<p>
Lorem 1psum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

14 | | </p> Line 15 i1s where the error

15 < > . .
- & manifests itself

1 Nu Markup Checker Problem

15 No “p” elementin scope but a “p” end tag seen. </p>

W3C error messages are

written 1in “humanish”

Line 14, Column 9 INS HTML ¥ Spaces: 2



) test.html| (Getting Started) — Brackets

Working Files

<!doctype html>
<html>
<head>
<meta charset="UTF-8">
<title>Test Document</title>
</head>
<body>

index.html
test.html

Getting Started

index.html

main.css

O 00O NOOUL A~ WDN K

<hl>Test Title</hl>

screenshots

—
O

ladl quick-edit.png
test.html

—&
—

<p>
Lorem 1psum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

13 </p> :
» ’ Fixed!
1.5

i
N

€ r~ s - - e e i D i e R T Clg

Line 14, Column 1 INS HTML ¥ Spaces: 2




< & 8 temp.htm — Brackets

Working Files </div>

chartreuse-05.htm <footer>

index-02.htm <div class="container">
tertiary-01.htm <span class="copyright">
<img alt="Invertocat"
src="https://d2dfho4r6t7asi.cloudfront.net/assets/invertocat-
£10d7398407Fff679b054b8c4c86aa639.svg" />
charis.htm 143 <div class="copyright-text">Copyright &copy; 2014 <a
chartreuse-01.htm href="http://github.com">GitHub</a> Inc.
chartreuse-02.htm 144 <div class="crumb">All slide content and descriptions are owned by
chartreuse-03.htm creators.</div>
145 </div>
146 </span>
147
148 <ul class="1links">
149 <li><a href="/fag">F.A.Q.</a></1i>
L2 A2 i 150 <li><a href="/tos">Terms of Service</a></11>
temp.htm 151 <li><a href="/privacy">Privacy Policy</a></li>
tertiary-01.htm 152 </ul>
videos 153 </div>

colors-site-wu

chartreuse-04.htm
chartreuse-05.htm
Images

index-01.htm

10 Nu Markup Checker Problems X
11 Badvalueoctolytics-script-host forattribute name on element meta: Keyword octolytics-script-hostis not registered. <meta name="octolytics-af

25 Badvalue octolytics-dimension-user_id for attribute name on element meta: Keyword octolytics-dimension-user_id is not registered. <meta name="octolytics-di
25 Badvalue octolytics-dimension-user_username for attribute name on element meta: Keyword octolytics-dimension-user_usernameis notregistered. <metaname="octolytics-di
Elementdiv notallowed as child of element span in this context. (Suppressing further errors from this subtree.) <div class="copyright-text"
Considerusingthe hlelementasatop-levelheadingonly (allhl elements are treated as top-level headings by many screen readers and othertools). <h1>Talks by Bram Stein</

Considerusingthe hlelementasatop-levelheadingonly (allhl elements are treated as top-level headings by many screen readers and othertools). <h1>Speaker Details</h1>

Line 143, Column 1 INS HTML ¥ Spaces: 2



() iIndex.html (portfolio-sat) — Brackets
<p class="1tem-1ntro text-

muted">Learn the Linux command Lline!
agency.less </p>
lelclriand <iframe width="560" height="315"
src="https://www.youtube.com/embed/ns
BH_wgn-Bo"| frameborder="0"
allowfullscreen></1iframe>

—— | | | | | <div class="text-left">
font-awesome < p>

Working Files

portfolio-sat

fonts Use this area to describe your
img project. Lorem 1ipsum dolor sit
index.html amet, consectetur adipisicing
js elit. Est blanditiis dolorem

() LICENSE culpa 1ncidunt minus dignissimos

ma|l e e B TN B R R T e [ Y
1 Nu Markup Checker Problem x

README.md 455 The “frameborder” attribute on the “iframe” elementis obsolete. Use CSSinstead. <iframe width="560" height="315" src="https://www.youtube.com/embed/nsBH_w

Actually understandable!

Line 455, Column 113 — Selected 16 columns Errors: 2 INS HTML ¥ Spaces: 2



Duplicate Files
& Folders



iIndex

main

quick-edit

index.html (Getting Started) — Brackets

1 <!DOCTYPE html>

27 <html>
+ B ]

Available Themes Installed

Brackets Sort Text

Ingo Richter

0.1.4 —06/25/2015

Brackets Tools
Yasin Kuyu

0.2.0 —01/31/2015

Duplicate Files & Folders
Torin Pascal

1.1.0 —11/09/2014

Brackets Backup
Joselito Evangelista

1.0.4 — 10/09/2014

Drag .zip here or Install from URL...

17

-
Line 13, Column 46 — 208 Lines

|O‘ duplicate

Sort Text extension for Brackets. Provide operations to sort,
reverse, randomize and remove duplicate lines.
More info...

Translated into 2 languages, including yours

Brackets developer tools extension
More info...

Translated into 8 languages, including yours

Duplicate, copy, and move files and folders in the project
view.
More info...

File Backup Extension for Brackets. This extension will
create a backup copy (.bak) of the active file in its current
directory.

More info...

MADE WITH <3 AND JAVASCRIPT

Install

Install

Install

I
18

11>

INS

;S">

HTML ¥

< /title>

A

Spaces: 2



Right-click on a file (or folder) & select Duplicate

Note that this does not work for files under Working
Files



) test.html| (Getting Started) — Brackets

<!doctype html>
<html>
<head>
<meta charset="UTF-8">
<title>Test Document</title>
</head>
<body>

Getting Started

index.html

main.css

screenshots
ladl quick-edit.png
test.html

O 00O NOOUL A~ WDN K

<hl>Test Title</h1l>

= =
O,

<p>
Lorem 1psum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

13 </p>

14

i B

i
N

€ r~ s - - S M= = Ity Bt i e i e R S Eg s

Line 1, Column 1 INS HTML ¥ Spaces: 2




) test.html (Getting Started) — Brackets

Getting Started ‘< ldoctype html>

<html>

index.html
<head>

main.css

<meta charset="UTF-8">
<title>Test Document</title>
</head>
<body>

screenshots
ladl quick-edit.png
test.htyg

New File
New Folder

O 0o ~NOOUlL A~ WDNBK

Rename

<hl>Test Title</hl>

Delete

—
O

Show in Finder

—
f—2

Find in...

Replacein...

<p>
Lorem ipsum dolor sit amet, consectetur
Eiii“me adipisicing elit, sed do eiusmod tempor
Mark incididunt ut labore et dolore magna aliqua. Ut
ﬁszii enim ad minim veniam, quis nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.
13 </p>
14

15V | | <p>

€ ~ o G S R E s S JPECaE AR 4T SR A RS [ A P 85 SRR

Line 1, Column 1 1 INS HTML ¥ Spaces: 2

-
N




) test.html| (Getting Started) — Brackets

Getting Started ‘< ldoctype html>

<html>
<head>
<meta charset="UTF-8">
<title>Test Document</title>
</head>
<body>

index.html

main.css

screenshots

ladl quick-edit.png

test copy.htm| effsmssave

test.html

O 00O NOOUL A~ WDN K

<hl>Test Title</hl>

= =
O,

<p>
Lorem 1psum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

13 </p>

14

i B

€ r~ s - - S M= = Ity Bt i e i e R S Eg s

i
N

Line 1, Column 1 INS HTML ¥ Spaces: 2



o test copy.html (Getting Started) — Brackets

<!doctype html>
<html>
<head>
<meta charset="UTF-8">
<title>Test Document</title>
</head>
<body>

Getting Started

index.html

main.css

screenshots
ladl quick-edit.png
test copy.hig

New File

test.html

New Folder

O 0o ~NOOUL A~ WDN B

T
N

Rename

<hl>Test Title</hl>

Delete

—
O

Show in Finder

—
f—2

Find in...
Replacein...

<p>
Lorem 1psum dolor sit amet, consectetur
- adipisicing elit, sed do eiusmod tempor
Mark incididunt ut labore et dolore magna aliqua. Ut
Hoveto fere enim ad minim veniam, quis nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.
13 </p>
14
15V | | <p>

- P~ e D SR S e N2 < (A . . S Bl ==l PR =N [ 14 S

Line 1, Column 1 INS HTML ¥ Spaces: 2

=
N

Refresh File Tree

Copy to Here




Debugging



Brackets provides 4 ways to debug your code

1. Colors
2. Nu Markup Checker

3. Indentator
4. Live Preview



Colors



) test.html| (Getting Started) — Brackets

Working Files
<hl>Test Title</hl>

index.html
test.html

<p>
o <p>
Getting Started Lorem 1psum dolor sit amet, consectetur

adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

</p>

</p> If you see red,

- there’s a problem

Duis aute 1rure dolor 1n reprehenderit 1n voluptate
velit esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non proident,
sunt 1n culpa qui officia deserunt mollit anim 1d

est laborum.

1Q ¢ I'n>
Line 14, Column 9 INS HTML ¥ Spaces: 2

index.html
main.css
screenshots

ladl quick-edit.png
test.html




Nu Markup Checker



) test.html| (Getting Started) — Brackets

Working Files

<hl>Test Title</hl>

index.html

test.html
<p>

<p>
Getting Started Lorem +ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

i If you see an error symbol,
there’s a problem

index.html
main.css
screenshots

ladl quick-edit.png
test.html

<p>
Duis aute 1rure dolor 1n reprehenderit 1n “%oluptate
velit esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non proiderit,
sunt 1n culpa qui officia deserunt mollit anim 1d

est laborum.

1Q ¢ I'n>
Line 14, Column 9 INS HTML ¥ Spaces: 2




Indentator



) test.html| (Getting Started) — Brackets

Working Files

<hl>Test Title</hl>

index.html

test.html
<p>

<p>
Getting Started Lorem +ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut
enim ad minim veniam, quils nostrud exercitation
ullamco laboris nisi ut aliquip ex ea commodo
consequat.

</p> o o o
i If your indentation is screwy,
there’s a problem

index.html
main.css
screenshots

ladl quick-edit.png
test.html

<p>
Duis aute 1rure dolor 1n reprehenderit 1n voluptate
velit esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non proident,
sunt 1n culpa qui officia deserunt mollit anim 1d

est laborum.

1Q ¢ I'n>
Line 14, Column 9 INS HTML ¥ Spaces: 2




[.ive Preview



@ 0O
Working Files

bootstrap.css
index.htm
photoswipe.css

» portfolio.css

Portfolio-Bootstrap

CSS
bootstrap-theme.css
bootstrap-theme.css.r
bootstrap-theme.min.
bootstrap.css
bootstrap.css.map
bootstrap.min.css
photoswipe.css
portfolio.css

fonts

Images

index.htm

JS
bootstrap-lightbox.|s
bootstrap-lightbox.mi
bootstrap.js
bootstrap.min.js
code-photoswipe-1.0..
klass.min.js
simple-inheritance.mi

portfolio-bootstrap-1.htn

\ 4
\ 4 class="conta
Scott Gran
About
About
\ 4
Scott Grar

auctor orci et lacus
nibh est. Pellentesqgl
turpis egestas. Donec

\ 4
Phasellus ac
ante quis velit hendr
velit. Pellentesque \
pellentesque lorem fe

DAv4 £
rOrciol

Portfolio
\ 4 class="gal
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Configuration



Spaces or Tabs?



A debate has raged for decades: spaces or tabs?

Tabs allow different users to indent at the size they like,
but can cause problems

Spaces are spaces are spaces — the same for everyone —
but can cause problems

Pick the one you like (I like spaces)
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<!doctype html>
<html>
<head>
<meta charset="UTF-8">
<title>Test Document</title>
</head>
<body>
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How many spaces? Or, if tabs, how big are they?
2,4, 0r 8?

8 & 4 seem too big to me & create nesting that is too
deep, so I always choose 2
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Click on View > Themes...
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2V <html>
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Themes Settings
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Common Themes



Certain themes appear in almost any editor that
supports theming

» Monokai
» Soda
» Solarized



You should check those theme out first

» They probably will meet your needs
» If you switch to a different editor, you can keep using
your theme



Solarized

Originally developed in 2010 (for Vim?)



SOLARIZED

Precision colors for machines and people

PLa XStaté
{ windows¥

- lele
‘saveﬁ
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end
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SOLARIZED

Meet the Man Behind ‘Solarized, the Most Important

Color Scheme in Computer History

It took Ethan Schoonover six months to choose the 16 most prevalent colors in computer

sclence

By Jack Smith IV « 02/27/15 9:55am

How many
themes get
articles
written
about them?
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1 <!DOCTYPE html>
29V <html>

\_‘ 0, ’_‘ | O‘ solarized

Available Themes Installed

Solarized Dark Solarized Dark theme
qUiCk-edit Shane Ramiah More info... Install

1.1.0 — 05/13/2015

test
solarized-dark Solarized Dark theme as described by

Damien Robertson http://ethanschoonover.com/solarized E < / t.i .t'Le >

1.0.0 — 09/12/2014 More info...

solarized-light Solarized Light theme as described by 18
Damien Robertson http://ethanschoonover.com/solarized
1.0.0 — 09/12/2014 More info...

;S">

Solarized-light-Theme beautiful selected low contrast color theme for brackets
jafar ali alshishani <chechnyan@inbox.com> designed by Ethan Schoonover. el
1.0.3 — 08/02/2014 More info...

Solarized Solarized Theme for Brackets

Miguel Castillo More info... Install Il >
1.0.0 —07/29/2014

Drag .zip here or Install from URL...

17 MADE WITH <3 AND JAVASCRIPT
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Getting Started <IDOCTYPE html>
<html>

index.html

main.css

<head>

SAeasieE - <meta charset="utf-8">

Y ajeliciciselispinz | | | <meta http-equiv="X-UA-Compatible"
content="IE=edge">

<t1tle>GETTING STARTED WITH BRACKETS</title>
<meta name="description" content="An
interactive getting started guide for

test.html

Brackets.">
G <link rel="stylesheet" href="main.css'">
10 | | </head>
117V | | <body>
12 | | | |
13 | | | | <h1>GETTING STARTED WITH BRACKETS</h1>
14 | | | | <h2>This 1s your guide!</h2>
15
167V | | | | <!I--
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NALILAL content="IE=edge">
I <title>GETTING STARTED WITH BRACKETS</title>
8 <meta name="description" content="An

interactive getting started guide for
Brackets.">

9 \ \ <link rel="stylesheet" href="main.css">
10 </head>

11V <body>

12

1’3 <h1>GETTING STARTED WITH BRACKETS</hl1>
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15
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Soda

Originally developed for Sublime Text (in 2011?)
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1 <!DOCTYPE html>
29V <html>

o+ 04 " - | O‘ soda

main Available Themes Installed

index.html

Monokai Dark Juice A dark brackets theme focused on readability, based on Dark
gqu ick-edit Jacob H Soda, Stripper and Monokai color schemes.
0.1.3 — 12/02/2015 More info...

Install

test

Monokai Dark Soda Dark theme based on Dark Soda and Monokai color < t.i .t'Le >
rain schemes. E /
1.0.9 — 11/02/2015 More info... ]

mannari A phantom color scheme for Brackets.
Ryota Mannari More info... Install

1.0.0 —05/15/2015

LightSoda The LightSoda light theme for Brackets!
Denisov21 More info... Install

0.1.5 —04/28/2015%

DarkSoda The DarkSoda is a Theme for Brackets!
Denisov21 More info... Install
0.1.6 — 04/28/2015

Drag .zip here or Install from URL...

17 MADE WITH <3 AND JAVASCRIPT
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index.html

main.css ] <head>

SOGHENE . <meta charset="utf-8">

= qlidedicpng | <meta http-equiv="X-UA-Compatible"
content="IE=edge">

<title>GETTING STARTED WITH BRACKETS</title>
<meta name="description" content="An interactive
getting started guide for Brackets.">

test.html

<link rel="stylesheet" href="main.css">
</head>
<body>

<h1>GETTING STARTED WITH BRACKETS</hl>
<h2>This 1s your guide!</h2>
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<IDOCTYPE html>
2Y <html>

<head>

<meta charset="utf-8">

<meta http-equiv="X-UA-Compatible"
content="IE=edge">

<title>GETTING STARTED WITH BRACKETS</title>
<meta name="description" content="An interactive

getting started guide for Brackets.">
\ | <link rel="stylesheet" href="main.css">

</head>
<body>

<h2>This 1s your guide!</h2>
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Monokai
Originally developed for TextMate in 2006

Many variants, some combined with Soda



index.html (Getting Started) — Brackets

1 <!DOCTYPE html>
29V <html>

\_‘ 0, ’_‘ |O‘ monokai

Available Themes Installed

Monokai Dark Juice A dark brackets theme focused on readability, based on Dark
gqu iIck-edit Jacob H Soda, Stripper and Monokai color schemes.
0.1.3 —12/02/2015 More info...

Install

test

Monokai Dark Soda Dark theme based on Dark Soda and Monokai color E< / t_i t-Le S

rain schemes.
1.0.9 — 11/02/2015 More info... |

18

mannari A phantom color scheme for Brackets.
Ryota Mannari More info... Install
1.0.0 — 05/15/2015

;S">

Monokai This dark theme is based on the monokai color scheme from
Steffen Bruchmann Sublime Text.
1.0.8 — 01/02/2015 More info...

Son of Monokai Monokai based Brackets theme. Bolder font. Italic
Michael Adaixo comments. Other perks. Il>
0.1.2 — 10/13/2014 More info...

Drag .zip here or Install from URL...
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> index.html
main.css
v screenshots
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1 <!DOCTYPE html>
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Index.html (Getting Started) — Brackets

charset="utf-8"
http-equiv="X-UA-Compatible"
content="IE=edge"

GETTING STARTED WITH BRACKETS
name="description" content="An

interactive getting started guide for
Brackets."

rel="stylesheet" href="main.css"
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Installing Themes



Q|

Available Themes Installed

Rods & Cones Color blind friendly theme for anyone with Deuteranomaly

Sean Peterkin and Deuteranopia: the most common forms of color
blindness. It will make your rods and cones very happy! :)
More info...

Traffic Lights Theme Traffic Lights Dark Theme
Chris Tennant More info...

Material Color (light) Inspirate in Material Color and coffee color
Fred Pizarro More info... Install

Coder theme Dark theme based in Aotm One Dark
lvan Grimaldo More info... Install

Coffee Color Inspirate in the product coffee !!..
Fred Pizarro More info... Install

Drag .zip here or Install from URL...

Extension Manager > Themes...



Available Themes Installed

Rods & Cones

Sean Peterkin

Traffic Lights Theme

Chris Tennant

Material Color (light)

Fred Pizarro

Coder theme

lvan Grimaldo

Coffee Color

Fred Pizarro

Drag .zip here or Install from URL...

Q|

Color blind friendly theme for anyone with Deuteranomaly
and Deuteranopia: the most common forms of color
blindness. It will make your rods and cones very happy! :)
More info...

Traffic Lights Dark Theme
More info...

Inspirate in Material Color and coffee color
More info...

Dark theme based in Aotm One Dark
More info...

Inspirate in the product coffee !!..
More info...

Like 1t? Click Install

Install

Install

Install




Q|

Available Themes Installed

Rods & Cones Color blind friendly theme for anyone with Deuteranomaly

Sean Peterkin and Deuteranopia: the most common forms of color
blindness. It will make your rods and cones very happy! :)
More info...

Traffic Lights Theme Traffic Lights Dark Theme
Chris Tennant More info...

Material Color (light) Inspirate in Materii! Color and coffee color
Fred Pizarro More info... Install

Coder theme Dark theme based in Aotm One Dark
lvan Grimaldo More info... Install

Coffee Color Inspirate in the product coffee !!..
Fred Pizarro More info... Install

Drag .zip here or Install from URL...

Click on More info... to see a preview of the theme



| NON | 5 O S < a )4 5 @ @ GitHub, Inc. github.com/christennant3/ct_traffic_lights & (3]

Bonjour v S-Foc Entv RSGv WSv Bestv Gv Socv Appsv letsv Newsv Savev

christennant3/ct_traffic_lights: Brackets dark theme

0 This repository Pull requests Issues Gist Q. St v
.| christennant3 / ct_traffic_lights ®O@Watchv 1  %Star 0  ¥Fork 0
<> Code (D) Issues 0 (‘) Pull requests 0 1"l Projects 0 = Wiki 4~ Pulse \li Graphs

Brackets dark theme

D 4 commits I 1 branch © O releases 22 1 contributor sts MIT
Branch: master v New pull request Create new file  Upload files  Find file | Clone or download ~ -
christennant3 committed on GitHub Add files via upload Latest commit bee38ca 10 hours ago
=) LICENSE Initial commit 7 days ago
=) package.json Add files via upload 10 hours ago

=) theme.css Add files via upload 10 hours ago

-« e B - < - 2 o E < = oy
- - - -

= 4 7 v T W & LN a8 - T g 7Y I P W o o I

-

'No preview, no install

© 2016 GitHub, Inc. Terms Privacy Security Status Help Contact GitHub APl Training Shop Blog About



Available Themes Installed

Rods & Cones

Sean Peterkin

Traffic Lights Theme

Chris Tennant

Material Color (light)

Fred Pizarro

Coder theme

lvan Grimaldo

Coffee Color

Fred Pizarro

Drag .zip here or Install from URL...

Q|

Color blind friendly theme for anyone with Deuteranomaly
and Deuteranopia: the most common forms of color
blindness. It will make your rods and cones very happy! :)
More info...

Traffic Lights Dark Theme
More info...

Inspirate in Material Color and coffee color
More info...

Dark theme based in Aotm One Dark
More info...

Inspirateint - »duct coffee !!..
More info...

Let’s try another one...

Install

Install

Install
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FredPizarro/theme-dark-coffee-color: Inspirate in the product coffee !!..

@ S < a 4 P @ @ GitHub, Inc. github.com/FredPizarro/theme-dark-coffee-color & (3 U

ul

: , : -
O This repository Pull requests Issues Gist A +~ 4
| FredPizarro / theme-dark-coffee-color OWatchv 1 %Star 0 YFork O
<> Code (D) Issues 0 1 Pull requests 0 'l| Projects 0 EE Wiki 4~ Pulse 1\l Graphs

Inspirate in the product coffee !!..

0D 11 commits ¥ 1 branch © 0 releases 42 1 contributor 5fs MIT
Branch: master v New pull request Create new file  Upload files  Find file ' Clone or download ~ :
Q FredPizarro Update Latest commit 32adda@ 8 days ago
BB screenshots upload 01 8 days ago
BB themes add less 8 days ago
E) LICENSE Initial commit 8 days ago

=) README.md upload 01 8 days ago

=) package.json 8 days ago

=F README.md
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Extensions




Scott Granneman

Writing  Presentations  Teaching WebDev  Tech  Personal Site Map  Search

Changing Tags

Home » Web Dev » Editors » Brackets » Extensions » Changing Tags

e Developer: Ekaterina Dontsova

e Find Changing Tags on the Brackets Extension Manager

e What it does: Quickly rename elements in matching opening & closing tags

e How to use it: Select the element in an opening tag that you wish to change & enter a new element — & you’re finished!

If for some reason you don’t like Changing Tags, take a look at Tag Renamer. It’s similar to Changing Tags, but not as smooth to use.

e Developer: 0674272bac (AKA ucym)

e Find Tag Renamer on the Brackets Extension Manager

e What it does: Quickly rename elements in matching opening & closing tags

e How to use it: Press Ctrl+Shift+R (Windows & Mac), enter a new element, & press Enter



Scott Granneman

Writing  Presentations  Teaching WebDev  Tech  Personal

Join Lines

Home » Web Dev » Editors » Brackets » Extensions » Join Lines

e Developer: Hamdan Javeed

e Find it on the Brackets Extension Manager

e Whatitdoes: “Joins the next line or all the lines selected, with or without whitespace”

e How to useit: Install it & select one of the following menus, or use the associated key commands

Here’s some text that is not joined.

@ e index.html (Getting Started) — Brackets

Working Files 26 <=
27 WHAT IS BRACKETS?
28 —-—->

iIndex.html

SiteMap  Search




Scott Granneman

Writing  Presentations  Teaching WebDev  Tech  Personal Site Map  Search

Surround Extension

Home » Web Dev » Editors » Brackets » Extensions » Surround

e Developer: Patrick Edelman

e Finditon the Brackets Extension Manager (note that it is called Brackets Surround)
e Whatitdoes: “...wrap selected text in Brackets”

e How to useit:

1. Select the text around which you want to insert HTML or characters
2. Press Ctrl+Shift+J (Windows) or {+ $8 J (Mac)
3. Enter HTML tags or characters & press Enter

Some examples:

e <span> automatically adds the </span>
e <a href="https://www.granneman.com'"> automatically adds the </a>



Scott Granneman

Writing  Presentations  Teaching WebDev  Tech  Personal Site Map  Search

CSS Class Code Hint Extension

Home » Web Dev » Editors » Brackets » Extensions » CSS Class Code Hint

e Developer: growlscript

e Find it on the Brackets Extension Manager (note that it is called Brackets CSS Class Code Hint)

e What it does: Automatically detect your CSS classes & IDs & makes it far quicker & easier to enter them in your HTML
e How to use it: Start typingin a class or ID name & Brackets will offer to autocomplete their names

Contact All content, unless under a Creative Commons n , in m u oS

license, is © 1997-2017 Scott Granneman.
Email scott@granneman.com
(Take a look around—a lot of content is licensed

Voice  314-780-0489 under a Creative Commons license which sives



Thank you!

scott@granneman.com
www.granneman.com
ChainsawOnATireSwing.com
(@scottgranneman

jans@websanity.com
websanity.com
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Changelog

2021-03-29 1.2: Added notice that Adobe will no longer
support Brackets & suggests moving to Visual Studio

Code

2017-11-01 1.1: Switched theme to Granneman 1.4;
minor formatting fixes; corrected info re: finding
themes; changed subtitle

2017-10-31 1.0: First release



Licensing of this work

This work is licensed under the Creative Commons Attribution-ShareAlike 4.0 International License.
To view a copy of this license, visit http://creativecommons.org/licenses/by-sa/4.0/.

You are free to:

» Share — copy and redistribute the material in any medium or format
» Adapt — remix, transform, and build upon the material for any purpose, even commercially

Under the following terms:

Attribution. You must give appropriate credit, provide a link to the license, and indicate if changes were made.

You may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your
use. Give credit to:

Scott Granneman « www.granneman.com ¢ scott@granneman.com

Share Alike. If you remix, transform, or build upon the material, you must distribute your contributions under
the same license as the original.

No additional restrictions. You may not apply legal terms or technological measures that legally restrict others
from doing anything the license permits.

Questions? Email scott@granneman.com



